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1. Introduction 

The Grease Thief Analyzer (GTA) measures the consistency of in-service lubricating grease 

and compares it to the values obtained from a reference sample. A linear actuator is used to 

push a load cell which pushes the handle of a Grease Thief (GT). A second actuator moves a 

table holding a substrate. This substrate is moved at a speed proportional to the grease thief 

movement, so the extruded grease is captured as a thin-film along the length of the substrate. 

The die extrusion process conforms to the standard practice outlined in ASTM D7918. This 

practice will also address the additional tests that can be performed with the full grease thief, 

and with the thin-film substrate, including: 

 

• Ferrous Density 

• RULER/Linear Sweep Voltammetry 

• Optical Spectroscopy/Grease Colorimetry 

• Moisture by Relative Humidity Sensor 
 

• Grease Particle Counting 
 

The force required is measured as the grease is extruded through the extrusion die, which is 

threaded onto the other end of the GT. The test cycle includes 3 speeds and rapid transitions in 

grease pressure to provide insight into shear and non-Newtonian rheology, and the force data is 

averaged for each speed to calculate the “Grease Thief Index” or GTI. The GTI is the ratio of the 

used grease load to the reference load, reported as a percent. 

 

Appendix III shows a list of terms used within this document. This can be referenced as needed 

throughout the analysis process. 
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WARNING 
 

Please read carefully and strictly follow the instructions in this section. Failure to do so could 

result in instrument failure and/ or personal injury. 

 

Changing the instrument’s operating program and logic can present a hazard to the users of 

this instrument and will void the instrument warranty. If reprogramming is needed, please 

consult an authorized Grease Thief representative. Do not modify any drive parameters. 

Improper functioning of instrument may occur. 

 
 

 

 
1. General Operating Instructions 

2. Safety 

 

• For major instrument repairs and tear down, disconnect and lock out all power. 

 
• Read all signs on instrument. Do not remove, modify, or deface any sign. Replace all damaged 

signs. 

 

• If safety instructions are required in another language, please contact a local translator. 

 
• Personnel should keep clear of the moving parts at all times. 

 
• The functionality of the door closure interlock is extremely important for the safety of the 

personnel. 

 

• All covers must be in place before operating the instrument. 
 

 
 

2. Maintenance 
 

• Remove all debris from the surrounding area of the instrument and ensure that all personnel 

stay clear of the instrument operating parts. 

 

• Keep work area uncluttered and well lit. 

 
• To ensure proper instrument operation, use the specified power sources listed in Appendix V 

of this manual. 

 

• Before any service is performed on this unit, turn power off and unplug from power source. 

Service should be provided only by trained and authorized personnel. 
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WARNING 
 

Failure to utilize and ensure properly connected and functional interlocks can result in 

improper instrument operation and/or personal injury. 

 
 

• Follow all maintenance and service instructions in this manual. 

 
• The instrument should be inspected daily, and any worn or broken parts should be noted, and 

service scheduled for replacement and/or repair. 

 

3. Moving Instrument Parts 
 

• Disconnect power cord to isolate instrument from all power sources before cleaning and 

servicing unit or accessing the internal area of the enclosure to perform any action not 

specifically outlined as a normal operational step in this manual. 

 

• When instrument is in operation, keep the enclosure door fully closed and stay away from the 

moving parts. 

 

• Before operating this instrument, all covers and guards must be in place and all safety devices 

working. 

 

• Never put any part of your body into the instrument enclosure or near any moving or 

electrically energized parts while the instrument is in operation or when electrical power is 

supplied to those electrical parts. 

 

• Do not attempt to manually move any instrument parts that are normally mobile only under 

power and through the influence of the motors and gear units. 

 

 

 
 

4. Instrument Installation 
 

• All customer interlocks must be connected as shown in this manual's electrical drawings. 

 
• Be familiar with the locations of safety interlocks, guards, and enclosure panels. 

 
• Do not defeat any safety interlock or safety device. 

 
• Do not operate instrument with any safety devices/guards removed. 
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• Before operating the instrument, ensure that all safety interlocks, guards, and enclosure 

panels are in place and operating properly. 

 

• Always secure the instrument in place, on a level solid surface sufficient for the weight of the 

instrument and adjust feet to achieve a stable and level orientation before running the 

instrument. 

 

5. Personal Protection 
 

• To prevent back or other body injuries, your employer must provide proper lifting and/or 

handling instructions. Do not attempt to lift the instrument without help. Make sure to bend at 

knees and lift straight up. 

 

• When operating or installing unit, always use proper Personal Protective Equipment (PPE) 

including appropriate gloves and goggles, in accordance with local procedures and the required 

PPE in the SDS for the product being handled. 

 

6. Lockout/Tagout 
 

• Follow local safety guidelines for instrument lockout procedures and other important 

lockout/tagout guidelines. 

 

• Wear appropriate gloves when handling grease or other chemicals. 

 
• Be familiar with all lockout sources on this instrument. 

 
• Even after an instrument has been locked out, there may be stored energy in the system. 

 
• Wait at least one minute before servicing electrical capacitors in order to ensure that all stored 

energy is relieved. Service this instrument, including electrical or electronic components should 

be performed only by trained and authorized personnel. 

 

• Always turn unit off using the power switch and remove and lockout the power cable before 

servicing any internal components, including moving mechanical and electrical or electronic 

components. 

 

7. Operating the Instrument 
 

• Never operate this instrument in an explosive atmosphere. 

 
• Be sure that all guards are in place and all safety devices are working properly. 
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DO NOT operate the instrument with any safety devices removed. 

 
• Keep all unauthorized personnel away from the instrument operating area. 

 
• For guidance on proper sampling taking procedures see ASTM Standard Practice D7718. 

 
• Always use proper Personal Protective Equipment (PPE) while handling grease samples, 

including appropriate material gloves and goggles, in accordance with local procedures and the 

required PPE in the SDS for the product being handled. 

 

• Ensure the instrument is wiped down between runs and to prevent cross contamination. 

 
• Ensure that Grease Thief samplers, extrusion dies, and substrates are in good condition and 

undamaged prior to use. Do not utilize any separated or delaminated substrates, cracked or 

misshapen dies, or misaligned or damaged Grease Thief samplers. 

 

• If a damaged or misaligned Grease Thief sampler is submitted for analysis, transfer the grease 

contents to a new Grease Thief sampler and conduct analysis after confirming the good 

condition of the sampler, die and substrates to be used. 

 

• Do not reuse Grease Thief samplers, substrates or dies as this will result in contamination with 

grease from previous runs and will provide inaccurate data results. 

 

• Reusing extrusion dies can result in over-pressurization and damage to the unit. Reusing 

substrates can cause separation of materials and damage to the instrument components. This 

could also compromise the quality of the sample being tested. 

 

3. Instrument Initialization 

Note: Before powering on your unit or accessories, consult Grease Thief Analyzer Power 

Statement for proper power and adapter configurations. 

 

1. Plug in the Grease Thief Analyzer using the included power cord. The power connection 

is located above the name plate at the rear of the unit. 

2. Place the VCM next to the unit, close enough that the ethernet cords can reach the rear 

of the unit. Use the power cord from the VCM box and plug in the VCM at the Power In 

connection (top left in Figure 1) and plug other side into wall faceplate. 

3. Open the white box labeled “Ethernet Cords” and use the 3 colored cords to connect the 

VCM to the Grease Thief Analyzer using Figure 1 as a guide. The corresponding colored 
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Remote On/Off 

Power 

LED 

(PWR 

 
 

cable should be used for each of these connections. 
 

 

Figure 1 Block diagram of the Vector Control Module (VCM) with color-coded ethernet ports 

 

a. Use plug 1 (black) for connection to local server 

b. Use plug 2 (yellow) for the Grease Thief Canty Camera (Port 2 on rear of 

instrument) 

c. Use plug 3 (blue) for the LED controller (Port 3 on rear of instrument) 

d. Use plug 4 (green) for the Grease Thief Analyzer (Port 1 on front of instrument) 

4. Open the monitor box and remove its contents. Plug in the monitor and use the included 

VGA cable to connect the monitor to the VCM into the connector labeled “VGA” in the 

lower right corner of Figure 1. 

5. Open the keyboard/mouse combo box and remove its contents. Plug in the keyboard 

and mouse to the VCM using the USB-3 ports. 

First Time Operation 

**Warning** - When powering on the GTA, and whenever the imaging system is used, a 

strobe flash is emitted. Strobe flash can be problematic for some individuals with 

medical conditions. Verify no health issues with users before operation. 

6. Verify the VCM is powered on by checking the “PWR” LED is lit. (top right corner of 

Figure 1). If not, press the power button located on the right-facing side of the VCM 

when positioned in the same orientation as Figure 1. 

7. Power on the Grease Thief Analyzer using the switch at the rear of the unit located 

directly below the power supply cord. 

8. Power on the monitor by pressing the power button located on the far right of the 
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underside of the monitor. 

9. Once everything is powered on, check the monitor. If you see a selection of profiles to 

log into, move on to step 5. If the screen looks like Figure 2, skip to step 7. 

10. There will be four user options on the VCM startup screen: 

a. Operator: No sign-in required; use this profile to run samples 

b. User Admin: password - cv12345; used for modifying local properties 

c. Canty Admin: Remote access only 

d. VCM Admin: Remote access only 

11. Sign into the Operator profile, and the VCM home-screen will display with options on the 

left side of the screen (Figure 2). 
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Figure 2 VCM home- screen window with description of possible selections 

 
 
 
 
 
 

Canty Vision software: Controls camera and LED strobe 

Grease Thief Software: Controls Grease Thief Analyzer 

File Explorer: Provides access to files saved on VCM 

Display Settings: Admin Use Only 

Internet Explorer: Provides access to the internet 

Administrator: Admin Use Only, used for technical support 

Virtual Keyboard: Opens on-screen keyboard 

User Manual: Opens manual PDF for VCM 

Remote Support: Allows for remote technical support 

Reboot System: Restarts VCM 

Shutdown System: Shuts down the VCM 

 
 
 
 
 

 
System Health Info: Displays VCM 

temperature, runtime, and load data. 



10 

       

 

Rev. 5 
4/11/2023 

 
 

12. The Canty Vision software should open automatically upon sign-in, but if not, click the 

“Open CV Software” button on the left side to launch Canty Vision. This program 

controls the camera and LED controller in the Grease Thief Analyzer. 

13. Test the connectivity of the LED controller by selecting the “Tools” dropdown at the top, 

then “Hardware”, then “LED Controller”. This will open a window called “Canty LED 

Controller.” 

14. Once the LED controller window opens, the LED in the unit should start flashing. If not, 

refer to the Troubleshooting section of this SOP to test connectivity of the LED controller. 

15. Close out of the “Canty LED Controller” window using the red “X” in the top right corner 

to return back to the Canty Vision home page. Select “Live Image” from the Canty Vision 

homepage in the top left of the window. A new window will open called “Automated 

Background Adjustment.” This will show what the camera is seeing. Open the Grease 

Thief Analyzer and remove the cap from the camera. Wave something in front of the 

camera and check the monitor to make sure the camera is connected properly. If not, 

refer to the Troubleshooting section of this SOP to test connectivity of the Canty 

Camera. 

16. Once the camera has been verified, close out of the Live Image window and return to 

the LED Controller window (Tools -> Hardware Settings -> LED Controller). Turn off the 

strobe light by selecting the “Output” box at the bottom under the “In Software” column 

and select “Disable”. Then, click “Send” in the top right corner, and the LED inside the 

unit should turn off. (See Figure 3 below) 
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Figure 3 shows the LED Controller window. The red box shows the Enable/Disable function for the LED strobe light 

inside the Analyzer. The green box shows the “Send” button to click after changing settings in the LED Controller 

window. 
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17. Close out of the “Canty LED Controller” window by selecting the red “X” and close out of 

the Canty Vision software again using the red “X” to return to the VCM home-screen. 

18. Select the second option from the window on the left labeled “Data Communications” to 

open the Grease Thief Analyzer software. This will be used to communicate from the 

VCM to the Grease Thief Analyzer and will store the die extrusion results of each test. 

19. A Calibration Overdue window may pop up once the Grease Thief Analyzer software is 

opened. Click “OK” and the calibration menu will open. This screen will be used when 

ready to calibrate the instrument before running samples. Click on “Data” in the top left 

and then select “Samples” to return to the main sample menu of the Grease Thief 

Analyzer software. 

20. To ensure the instrument is connected properly, click “Import from GTA” on the left side 

above the data table. Once the new screen appears, click “Connect” and a list of the 5 

most recent tests will appear. If these tests show up, the unit is correctly connected to 

the VCM. If an error window pops up after clicking “Connect”, there is an issue with the 

connection between the unit and the VCM. Refer to the Troubleshooting section of this 

SOP to test connectivity of the Grease Thief Analyzer. If connected properly, the screen 

should look like Figure 4. 
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Figure 4 shows the sample “Import From GTA” screen with the five most recent tests. This should be what the 

screen looks like if the Grease Thief Analyzer is connected properly 

 

21. Close out of the Grease Thief Analyzer software using the red “X” to return to the VCM 

home-screen. 

22. If these steps were followed and all components are properly connected, the VCM and 

Grease Thief Analyzer are ready for sample analysis. 

23. Before operating the instrument for the first time and anytime the power is cycled, 

the actuator home position needs to be reset. To do this navigate from the Menu to 

the Sample screen. This will be the screen the instrument boots to as well. The not 

homed error will be displayed at the top of the screen. Ensure the door is closed and the 

loading zone is clear. Press the “Start” button and the actuators will return to the home 

position sensors and set the home position. 

24. Before running the instrument for the first time, perform a calibration check (covered in 

the Calibration Checks section). Perform daily calibration checks before use. The full 

standardization procedure is only necessary if the instrument fails a daily calibration 

check. 



14 

       

 

Rev. 5 
4/11/2023 

 
 

4. Software Setup 

1. Open the “Data Communications” software program. 
 

2. Under the Set-up → General menu set the default report, export, and import paths. Lab 
name and a Logo, which will appear on the .pdf reports, may also be changed here. These 
paths are necessary to save the report and image files. They can be the same folder, but 
should be filled in with enough information to identify the sample tested. 

 

3. Leave the Database Connection String blank and the Disable Automatic Upload unchecked 
unless directed by technical support. 

 

4. Under the Set-up → Lists menu you can set default entries for the sample identification 
fields. These lists can also up updated while naming samples. 

 

Figure 5 General information tab of the Grease Thief Analyzer software 
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5. Calibration Checks 

At the beginning of each working shift or daily, perform a calibration check to maintain the 

precision of the instrument. This procedure will compare the performance of the load cell to a 

known standard. If the results are beyond acceptable variations the full standardization 

procedure should be run to calculate a new K and Offset that account for load cell drift. 

1. If this is the first time running the instrument or after cycling power, set the home position of 
the actuator and check the IP address in the Set-up→General page of the analysis software. 
If instrument set-up has been completed, this step may already have been completed. See 
Instrument Initialization and Software Set-up for more details. 

 
2. Enter the Calibration Screen (shown below in Figure 6) from Navigation Menu by pressing 

the “Calibration” button on the touch screen. To return to the Navigation Menu at any time 
press the “Menu” button at the bottom left corner. See Navigation Map in Appendix I - 
Navigation Menu Map. 

 
 

Figure 6 Calibration Screen 

3. Go to the Load Cell Settings screen and confirm the Speed and Time values shown below in 
7. To change a value, select the field on the touch screen and input the desired value using 
the keypad, then press “Enter” to confirm. 

 

Flow 0.25 mm/sec 

Time 70 sec 

Figure 7 Load Cell Settings 
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4. If this is the first time running the instrument, the load cell K and Offset will have been set by 
the factory calibration. If the standardization procedure has been performed, the values in 
these fields should match those determined in the most recent standardization. 

 
5. Load the spring cell calibration device into the instrument and screw down the placement 

bracket with the black knob. Ensure the body of the spring cell is seated centered in the 
bracket and the shaft lines up with the center of the load cell well, by holding the spring cell 
above the bracket yolk and pushing down and back firmly. Tighten the bracket clamp until it 
doesn’t move. Loading a substrate onto the table under the spring cell can help maintain 
proper alignment. 
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Figure 8 Spring Can in bracket 

 
Figure 9 Spring Can aligned with load cell 

 

6. To enter or edit the sample ID, select the sample name field on the Calibration screen 
(shown below in Figure 10) using the touch screen. Use the alpha-numeric keypad to enter 
the sample name and press “Enter” to confirm. This name should uniquely identify the run 
being performed. For example cal or calck followed by the date and a sequence identifier if 
multiple runs are performed on the same day. (e.g. calck0714a) Use the alt key on the 
keypad to cycle through the pages of characters. 

Load Cell Well 

Placement Bracket 

Black Knob 
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Figure 10 Calibration Screen 

 

7. Press the “Start Calibration” button to begin the test. The trial should take 70 seconds and 
will consist of only the vertical compression of the spring cell. The calibration check does not 
need to be performed at a set temperature, so it can still be run if the low temperature error 
is displayed. 

 
8. When the test is complete, press the “Stop/Return” button on the touch screen to reset the 

instrument and then remove the spring cell. 

 
9. Open the Grease Thief Analysis software on the VCM. This software will be used to find the 

new Load cell K and Offset digital correction factors. 
 

9.1. Open the Data Communications program. 

 
9.2. Under the Calibration menu select “Calibration Check.” 

 
9.3. Click the “Get Data from Grease Thief” button, then click the “Connect” button, and 

select the file corresponding to the calibration trial you ran. Click the “Import 
Selected Row” button to transfer the trial. 

 
9.4. Click the “Calibration” button and the software will display at pass/fail rating 

based on a comparison of the calibration check trial to the known profile for the 
provided spring cell. 

CalCheck11172020 
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Figure 11 Software Calibration Screen 

 

10. If the calibration check passes, continue to use the instrument as normal. If the calibration 
check fails, attempt to re-run the check procedure. If multiple checks fail consecutively, the 
standardization procedure should be run. 

9.3 
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6. Standardizing the Instrument 

The force sensor analogue output is governed by a user set K and Offset. These values are set 

by comparison to a spring with known force response. Perform daily calibration checks to 

maintain the precision of the instrument and perform this full calibration procedure if the 

instrument fails a check. 

1. If this is the first time running the instrument or after cycling power, set the home position of 
the actuator and check the IP address in the Set-up→General page of the analysis software. 
See Instrument Initialization and Software Set-up for more details. 

 
2. Access the Load Cell Settings Screen (shown below in 12) from Navigation Menu by 

pressing the “Calibration” button on the touch screen, then the “Load Cell Settings” button. 
To return to the Navigation Menu at any time, press the “Menu” button at the bottom right 
corner. 

 

Figure 12 Load Cell Settings 

 

3. Confirm the Speed and Time values shown below in Figure 13 into the Load Cell Settings 
screen. To change a value, select the field on the touch screen and input the desired value 
using the keypad, then press enter to confirm. 

 
 

Flow 0.25 mm/sec 

Time 70 sec 

Figure 13 Load Cell Settings 
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4. Load the spring cell calibration device into the instrument and screw down the placement 
bracket with the black knob. Ensure the body of the spring cell is seated in the bracket and 
the shaft lines up with the center of the load cell well, by holding the spring cell above the 
bracket yolk and pushing down and back firmly. Tighten the bracket clamp until it doesn’t 
move. Loading a substrate onto the table under the spring cell can help maintain proper 
alignment. 

 
5. Return to the Calibration screen (shown below in Figure 14) by pressing the “Back” button or 

the “Calibration” button from the Navigation Menu. To enter or edit the sample ID, select the 
sample name field using the touch screen. Use the alpha-numeric keypad to enter the 
sample name and press “Enter to confirm. This name should uniquely identify the run being 
performed. For example, cal or calck followed by the date and a sequence identifier if 
multiple runs are performed on the same day. (e.g. calck0714a) 

 

Figure 14 Calibration Screen 

 

6. Press the “Start Calibration” button to begin the test. The trial should take 70 seconds and 
will consist of only the vertical compression of the spring cell. The horizontal table will not 
move. The calibration check does not need to be performed at a set temperature, so it can 
still be run if the low temperature error is displayed. 

 
7. Monitor the live force reading displayed on the screen. If it remains unchanged for the 

duration of the test the shaft alignment may be incorrect. Check the alignment and restart 
the test if necessary. 

 
8. When the test is complete, press the “Stop/Return” button on the touch screen to reset the 

instrument and then remove the spring cell. 

 
9. Now open the Grease Thief Analysis software on the VCM. This software will be used to find 

the new Load cell K and Offset digital correction factors. 
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9.1. Open the Data Communications program. 

 
9.2. Under the Calibration menu select Standardization. 

 
9.3. Click the “Get Data from Grease Thief” button, then click the “Connect” button, and 

select the file corresponding to the calibration trial ran. Click the “Import Selected Row” 
button to transfer the trial. 

 

Figure 15 Software Calibration Screen 

 

9.4. Check that the current values for the K and Offset match what are shown on the Load 
Cell Settings screen when the trial was run. Correct the values in the software to match 
the ones on the instrument if necessary. 

 
9.5. Click the “Standardize” button and the software will calculate and display a new K and 

Offset based on the calibration trial input. 

 
9.6. Input the new K and Offset into the Load Cell Settings screen. 
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10. This completes the standardization procedure. Press the “Menu” button on the instrument 
control panel to return to the Navigation Menu. Run a calibration check to confirm the 
passing status of the instrument. If calibration passes, the instrument may now be used to 
analyze samples. 

 
Note: If several consecutive checks fail directly following a standardization, the standardization 

procedure may need to be repeated. If this occurs multiple times or only a few tests are able to 

be run between standardizations, the instrument may need to be serviced. 

 
7. Running a Test (Sample or Baseline) 

Grease Thief Analyzer 

 
This test is a consistency comparison between in-service grease samples and a referenced 

baseline provided by the customer. To complete the analysis procedure, this test must be run 

on the sample as well as the new reference baseline. The test procedure is the same for 

samples and baselines, except for importing into the Data Communication software for 

comparison. 

 
1. Before analysis, the specimen must be packed into a Grease Thief (GT) 

 
2. Screw an extrusion die onto the open end of the GT. 

 
3. Turn the heater in the sample rack to on. 

 
3.1. To set the temperature, navigate to the Temperature Control screen (shown below in 

Figure 16) from the Navigation Menu by pressing the “Temperature Control” button on 
the touch screen. 

 

 
Figure 16 Temperature Control Screen 
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3.2. Press the “Heater Status” button to turn the heater on and off. 

 
Note: The “Temp Cal” button is for calibrating the Temperature sensors and will not be used 
during routine use. Use this feature only if instructed by technical support. 

 
3.3. The “Heater Status” button displays the current state on it. If it shows on, the heater is 

on, and pressing the button will toggle the heater off. 

 
3.4. The temperature set point should be set to 31°C for routine samples. 

 
3.5. The PID settings control the set-point tracking response of the temperature controller. 

The default PID values and Temperature Set-Point are shown below in Figure 17. 
 
 

Temp SP 31 

P 10 

I 1 

D 0 

Figure 17 Default Temperature Controller PID settings 

 

4. Samples must be loaded into the sample tray with the temperature control turned on for 15 
min prior to testing, to allow them to reach the appropriate temperature. 

 
5. Return to the Sample screen (shown below in Figure 18). 
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Figure 18 Sample Screen 

 

6. To edit the sample ID field, touch the button and enter the sample ID using the keypad. 
Then press “Enter” to confirm the selection. 

 
7. Once the sample has been allowed to reach the required temperature, open the door and 

place one substrate on the table as shown in the Figure 19 below. The substrate should sit 
loosely in the tray with the clear plastic side facing up, and overhang no more than 3/4” at 
either end. 
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Locking Bracket 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 19 Infrared sensor, the load cell, and the position bracket 

8. Hold the substrate by the edges and avoid touching the clear plastic side where the grease 
film will be captured. 

 
9. Flip the locking bracket on the right to secure the substrate to the table. 

 
10. Take the sample and place it in the position bracket, making sure that the narrow slot 

opening of the die faces the exit direction (right) as shown in the Figure 20 below. Again, 
avoid touching the areas that the grease makes direct contact with (such as the exit slit on 
the die) to prevent cross contamination of the sample. 

 
11. Take care when positioning the sample so the shaft of the Grease Thief will align properly 

with the load cell well. Hold the Grease Thief above the bracket and press gently downward 
and push the head of the die against the guide block before screwing the bracket clamp 
tight. 

 

12. Depending on the fill of the GT, the shaft may need to be manually advanced slightly for it to fit within 
the load cell well. 

 

Load Cell 

IR Thermocouple 

Position Bracket 
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IR Sensor 
Grease Thief 

Substrate 

Extrusion Die 

 
13. If the GT is underfilled, the handle may not initially rest within the well. If this is the case line 

the handle up with the load cell visually and preform the rest of the test normally. 

 

Figure 20 Grease Thief, extrusion die, substrate, and IR sensor in the analyzer 

 

14. A non-contact IR thermometer is used to monitor the temperature of the sample and when 
the temperature control is turned on will state “Press Start to Run” if the sample is at the 
appropriate temperature. If the message says “Low Temperature” remove the sample from 
the GT holder and place it back on the heating tray. If the message says “High 
Temperature” wait for the sample to cool before running the test. 

 
15. Press the “Start” button on the touch screen Main menu to start the test. 
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16. When the test is complete, open the door of the unit and unclip the substrate from the table. 

 
Caution: The instrument interlock will not allow the position to be reset until the door has been 
opened to remove the substrate and empty Grease Thief. Resetting the position before 
performing this step will wipe the extruded film off of the substrate. 

 
17. Remove the GT from the bracket and remove the substrate from the table by unclipping it 

and sliding it to the left. 

 
18. Close the door and press the “Stop/Return” button and prepare the unit for another run. 

 
Caution: The basic internal memory holds only 5 tests. As more tests are run, the oldest on the 

internal memory will be overwritten. Transfer tests to permanent disk space after each trial to 

prevent accidental data loss. 

 
19. The results are stored on internal memory until they are downloaded by the VCM. At that 

time runs are named and identified as a sample or a baseline. See Importing and 
Analyzing Data for more information. 

 
Canty Particle Counting System 

 

1. Load the Canty Vision Intelligent Analysis by clicking “Open CV Software” from the VCM 

home screen. 

2. Open the configuration file by going to File->Load Config. The default configuration file 

can be found under C:\Canty Configuration 

a. Open the Grease Thief_Configuration file. 

b. A prompt to open a classification file will also appear. 

c. Open the MRG_Classification.clf file. 

3. The LED display screen should open automatically and send a signal to the LED. 

a. In the case that it does not automatically open, turn on the LED display by 

navigating to Tools->Hardware->LED Controller. 

b. Under the “Output” setting, select “Enable” and then hit the “Send” button. 

c. This should turn the LED on. 

4. Exit the LED controller window. 

5. Run normal grease extrusion method, but do not return the tray and sample. 

6. Remove the now-empty Grease Thief™ from its bracket, do not to bump the load cell. 

a. For samples that are already extruded or are being run multiple time make sure 

to cycle the GTA door to allow the actuator to return to the home position. 

7. If necessary, move the substrate so that the maximum length of extrusion will be 
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Amount analyzed after adjustment Amount analyzed before adjustment 

 
 

recorded by the Canty system. 

 

 

Figure 21 shows the position of the substrate before and after repositioning to run particle count 

 
 

8. Click the “Live Analysis” button in the bottom left of the CVIA software seen in the image 

below. The “Analysis and Record” can also be pressed in place of “Live Analysis” if the 

user wants to record a video of the particle counting. 

a. This should bring up an auto-adjustment screen that will change the pulse and 

gain on the camera and LED for ideal imaging. 
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Figure 22 shows the sample analysis screen with an arrow pointing to the “Live Analysis” button 

 

READ STEPS 9-11 BEFORE PROCEEDING 
 

9. Enter your sample ID and press okay. Be prepared to return the GTA tray as soon as 

“okay” as pressed. 

10. As soon as the auto-adjustment screen indicator light in the top left corner changes from 

yellow to green to indicate completion press the “Stop/Return” button on the GTA 

touchscreen. 

a. Auto-adjustment can take anywhere from 15 seconds to 3 minutes. 

b. It is important that the tray is already moving by the time that the analysis begins, 

if it is not rerun the sample. 
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Figure 23 shows the “Automated Background Adjustment” window 

 

11. Once the run is finished hit the “Stop” button to stop canty recording. 

a. This will automatically save a report of the sample tested to 

C:\Users\Operator\Documents\Reports. 

 
Figure 24 shows the sample analysis screen with an arrow pointing to the “Stop” button. This should be pressed 

when the full substrate moves through the camera’s view. 

 

Clean-up 
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12. Turn off the LED by navigating to Tools->Hardware->LED Controller. 

13. Under the “Output” setting, select “Disable” and then hit the “Send” button. 

a. This should turn the LED off. 
 

 
Figure 25 shows the “LED Controller” window with arrows pointing at the “Enable/Disable” LED setting and the 

“Send” buttons 

 

14. Close out of the CVIA software. 

 
 

8. Importing and Analyzing Data 

1. If this is the first use of the software, set the default file paths for saving reports and 
Importing samples. See Software Set-up for more information. If the instrument has already 
been calibrated, this step may have previously been completed. 
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2. To retrieve data from the instrument, open the Grease Thief Analysis software. Go to the 
Samples page in the Data menu and click on the “Import from GTA” button. 

 
 

 
Figure 26 Import option in the Grease Thief analyzer software 
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3. Click the “Connect” button. 

 
4. Select the desired sample from the grid. 

 
5. Click the “Import Selected Row” button. 

 
 

Figure 27 Connect option and import data from selected row in Grease Thief software 
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6. Enter all known identifying information for the sample on the details page and click “Save.” 
These fields can be left blank and/or modified later if desired. This page can be returned to 
from the Samples page by clicking the “Edit/Details” button. 

 

Figure 28 Sample details page of the Grease Thief software 

 

7. The baseline list is populated with the records you have designated as baselines or 
references. 

 
7.1. If the baseline is unknown, you can leave this field blank, but the GT Index cannot be 

calculated without a reference. 

 
7.2. If the grease run is a baseline, leave this field blank. The entry can be designated as a 

baseline by selecting it on the Samples page and clicking the “Save as Baseline” button 
at the bottom of the screen. Ensure air bubbles/gaps are taken out of the baseline 
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spectrum before saving. See Modifying Data Points for more information. 

 
8. The lists for the sample identifiers can be managed in the Set-up→Lists menu or use the 

quick add buttons to add new labels from this screen. 

 
Printing Reports 

 

9. To review the result of the test, select the entry for the desired sample from the samples 
screen and click the “Reports/Graphs” button. This will display the graphical depiction of the 
trial. 

 
10. To generate the GT Index and save the results to file, click the “Generate Reports and 

Image” button. The graph will be saved in a .jpg format and the calculated results will be 
saved in both a .pdf and a .txt format. Ensure a Baseline is assigned before the reports are 
generated or the GTI will show as zero. See Importing and Analyzing Data Steps 6 and 7. 

 
11. Use the General page under the Setup menu to enter save locations for the reports and 

graphs. See the Software Set-up section for more information. 

 
12. The calculations take average force values from the 3 different speeds the test is run at. 

Due to hard particles or an air bubble/gap in the grease, parts of this data may deviate from 
the stable values. In these cases, the data points that deviate will need to be manually 
selected to be ignored from the calculations. To do this see the Modifying Datapoints 
section. 

 
13. Click the “Save” button to store changes and return to the Samples page. 

 
9. Modifying Data-points 

1. The calculations take average force values from the three different speeds the test is run at. 
Due to hard particles or an air bubble/gap in the grease, parts of this data may deviate from 
the stable values. In these cases, the data points that deviate will need to be manually 
selected to be ignored from the calculations. 

 
2. There are two places the data-points that make up the trial results can be modified. 

 
2.1. From the Samples page select the desired entry and click the “Edit Data Points” button. 

 
2.2. From the Samples page select the desired entry and click the “Reports/Graphs” button. 
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3. Make note of the data points to be removed from the calculations. 

 
4. In the Calculated Data grid, checked boxes indicate points that are included in the 

calculations. To ignore data points or a range of data points uncheck the boxes next to the 
desired points. Multiple points may be selected at one time on the Edit Data Points screen 

 
5. Use the drop-down menu to apply simple operations to the selected data set (ex. Enable 

and disable points). The original data will be preserved, but calculations will be performed 
on the modified data set. 

 
 

 
 

Figure 29 shows the Reports/Graph screen. The red box indicates the table used to modify the graph and 

remove unwanted data points. 

 

10. Temperature Sensor Calibration 
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In the event of damage or during troubleshooting it may be required to recalibrate the IR 

thermocouple used to monitor the grease temperature at the point of measurement. 

1. Fill a clean grease thief with a known new grease. 

 
2. Screw on the extrusion die and remove the white handle from the back of the GT. 

 

Figure 30 Filled Grease Thief without piston 

 

3. Embed a calibrated thermocouple in the grease entering through the back of the GT. The 
red piston may need to be removed as well to allow this. Select a grease medium that will 
not easily run out of the GT when the piston is removed if this is required. 

 

Figure 31 Omega thermoucouple embedded in Grease Thief 

 

4. Turn the preheating rack on and preheat the grease to ~40°C. This should take about 15 
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minutes. 

 
5. Check the embedded thermocouple and confirm temperature is sufficiently above 35°C. 

Several measurements will need to be taken as this grease cools to room temperature. If 
the GT is not above 35°C, put it back on the rack and continue preheating. 

 
6. Put the GT in the position block and ensure the IR thermocouple is aimed at the GT 

perpendicular to a flat surface on the GT. 

 

Figure 32 Thermcouple embedded in Grease Thief to test with IR sensor 

 

7. As the grease cools, take readings from the embedded thermocouple and the IR 
thermocouple on the instrument display every 10 seconds or every 0.5°C. 

 
8. The embedded thermocouple temperature will be the x values and the IR display 

temperature will be the y values in a coordinate system. 

 
9. Plot the points. Results should follow a linear relationship. If they do not, consider rerunning 

the trial or the sensor is potentially damaged. 

 
10. The line should follow the equation y=mx+b, where in a properly calibrated sensor m is 1 

and b is 0. y=(1)x +0. If the best fit trend line for the trial does not fall within acceptable 
tolerances 0.90<m<1.1 and -2<b<2. Recalculate the K and offset values for the instrument 
and input them into the Temp Cal screen. Main->Load Cell->Flow->Temp->Temp Cal. 
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10.1. To calculate the new Gain and offset values take the equation from the best fit line: 
y=mx+b and the current values for the Gain and offset in the instrument Temp Cal 
screen: GainCurrent, Offsetcurrent and put them into the equation below. 

 
10.2. New Gain= (GainCurrent) / (m) 

 
10.3. New Offset= -b/m+OffsetCurrent 

 
11. After the new K and Offset values have been set, rerun the original trial with the embedded 

thermocouple starting at step 3, taking data pair points and graphing again. The m and b of 
the best fit trend line of the new plot should fall within the acceptable range stated in step 9, 
or the sensor may be damaged. 

 
11. Recipes and Speed Profile Set-up 

The default speed profile has been tuned to be appropriate for the majority of grease samples 

NLGI grades 1-3. For very thin/thick grease samples or special cases, the speed profile can be 

modified for testing purposes. The recipe menu can be used to develop and save preset 

configurations, which includes the speed profile, cycle between them and back to the default. 

This procedure is used in troubleshooting and customization applications. This function 

will not be used in routine use. 

1. From the navigation Menu go to the Speed Profile page by pressing the “Speed Profile” 
Button. 

 
2. The normal test procedure goes through 4 steps. A pre-fill followed by 3 measurement 

steps. 

 
3. The speed and duration of these steps are listed and modifiable from this page. 

 
4. Consult OEM before making changes to these setting. Profiles that run outside of overtravel 

sensors will not provide the desired results. 

 
5. Changes to the Speed Profile or any other of the settings fields are saved to a recipe profile. 

The default initial profile is 1. 

 
6. To cycle between recipes or save the current settings to an existing recipe go to the Recipe 

page from the navigation Menu by pressing the “Recipe” button. 

 
7. Use the “Next Recipe” and “Previous Recipe” buttons to select your recipe profile. 
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7.1. Press the “Save Current to Recipe” button to save your current settings to the recipe 
selected. 

 
7.2. Press the “Load Recipe” button to fill all the settings fields with the values saved in the 

selected recipe. 

 
7.3. Do not load from an empty recipe as this will erase the values in all the settings fields. 

 
8. Default values for all speed profiles can be retrieved from the Appendix II section at the 

back of the manual. 
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12. Manual Actuator Adjustment 

Under some circumstances it may be desirable to adjust the position of the actuators manually 

outside of the preset routines. This can be achieved from the Jog Actuator screen. This 

procedure is used in troubleshooting and customization applications. This function will 

not be used in routine use. 

 
1. From the navigation Menu press the “Jog Actuator” button. 

 
2. Use the “Jog” buttons to move the desired actuator to the desired position. 

 
2.1. X is the horizontal table and Z is the vertical shaft. 

 
2.2. The + and – buttons refer to the direction of the test procedure. Z + is the down 

direction. 

 
3. The default home position is governed by position sensors and is set in step 23 of the 

Instrument Initialization section. 

 
4. If you manually move the actuators after the home has been set, you can return to the home 

position by going to the Sample screen from the navigation Menu and pressing the 
“Stop/Return” button. 

 
5. To clear the home position and set the current position as Home, press the “Force Home” 

button on the Jog Actuator page. 
 
Setting the Home Position - To set the home position either due to unit power cycling or error. 

1. Go to the main menu and select the option for Jog actuator. 

2. Use the Jog Z+ or Jog Z- button to adjust the height of the load cell until it reaches 4 ¼” inches from the 
top of the substrate holder to the bottom of the load cell housing. 

3. When the Load cell is set to the proper height, press the “Force Home” button and continue to the testing 
or calibration. 
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13. Troubleshooting 

1. Standardization set “K” to infinity. 

a. Rerun the standardization (steps found in section 6). 

b. When importing the new “K” and “Offset” values for the standardization, enter an arbitrary 
“K” value (between 3 and 5) into the “current values” box. 

c. Enter the new values in the load cell settings on the GTA. 

d. Re-run the calibration and standardize the instrument. 

e. Confirm values output from new standardization match the values displayed on the load 
cell settings screen. 

f. Run calibration as normal (steps found in section 5). 

g. If calibration passes proceed to sample analysis (steps found in section 7). If calibration 
fails, repeat steps 1d-1f. 

2. To test connectivity of the LED Controller: 

a. Log into the User Admin profile using password: cv12345 

i. Press “Ctrl-Alt-Delete” and select “Switch User” 

ii. Select User Admin and use the password above 

b. Navigate to the Control Panel and select “Network and Sharing Center” 

c. Under “Connections” click on “LED Controller” 

d. It may ask for the password again, use: cv12345 

e. Select “Properties” and double click “Internet Protocol Version 4” from the list of 

properties 

f. Under the “General” tab, ensure the “Use the Following IP Address” button is 

checked and fill in the following: 

i. IP Address: 172.16.1.11 

ii. Subnet Mask: 255.255.255.0 

g. Once these changes are made, return to step 5 in the “Installation” section of this 

SOP to test the connectivity of the LED controller. 

h. If this change does not work, contact MRG Laboratories for technical support. 

3. To test connectivity of the Canty Camera: 

a. Log into the User Admin profile using password: cv12345 
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i. Press “Ctrl-Alt-Delete” and select “Switch User” 

ii. Select User Admin and use the password above 

b. Navigate to the Control Panel and select “Network and Sharing Center” 

c. Under “Connections” click on “Camera” 

d. It may ask for the password again, use: cv12345 

e. Select “Properties” and double click “Internet Protocol Version 4” from the list of 

properties. 

f. Under the “General” tab, ensure the “Use the Following IP Address” button is 

checked and fill in the following: 

i. IP Address: 192.168.4.11 

ii. Subnet Mask: 255.255.255.0 

g. Once these changes are made, return to step 7 in the “Installation” section of this 

SOP to test the connectivity of the Canty Camera. 

h. If this change does not work, contact MRG Laboratories for technical support. 

4. To test connectivity of the Grease Thief Analyzer: 

a. Log into the User Admin profile using password: cv12345 

i. Press “Ctrl-Alt-Delete” and select “Switch User” 

ii. Select User Admin and use the password above 

b. Navigate to the Control Panel and select “Network and Sharing Center” 

c. Under “Connections” click on “Instrument” 

d. It may ask for the password again, use: cv12345 

e. Select “Properties” and double click “Internet Protocol Version 4” from the list of 

properties 

f. Under the “General” tab, ensure the “Use the Following IP Address” button is 

checked and fill in the following: 

i. IP Address: 192.168.1.30 

ii. Subnet Mask: 255.255.255.0 

g. Once these changes are made, return to step 10 in the “Installation” section of 

this SOP to test the connectivity of the Grease Thief Analyzer. 

h. If this change does not work, contact MRG Laboratories for technical support 
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Appendix I - Navigation Menu Map 
 

 

Navigation Menu 
 

  

 
Sample 

 

 

 

 
Calibration 

 
Load Cell Settings 

  

 

 Temperature 

Control 

 Temperature 

Calibration   

 

 
Jog Actuator 

 
Actuator Settings 

  

 

 
Speed Profile 

 

 

 

 
Recipes 
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NLGI 1-2 Speed Time 

1 0.58 20.0 

2 0.15 19.0 

3 0.73 13.0 

4 0.44 21.0 

 

NLGI 3 Speed Time 

1 0.058 200.0 

2 0.015 190.0 

3 0.073 130.0 

4 0.044 210.0 

 

 
 

Appendix II - Default Values 
 

Load Cell Settings 
 

Speed 0.25 

Time 70 

Load Cell K 1 

Load Cell 
Offset 

0 

 
 

Actuator Settings 
 

X Limit 300 

Accel/Decel 0.5 

X-Z Ratio 6.6 

Data Rate 0.1 

 
 

Temperature Control 
 

Temp SP 31 

P 10 

I 1 

D 0 

 
 

Speed Profiles 
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Appendix III - List of Terms 

1. Data Communications Program – Software provided with the instrument and used to store 
the results and print reports. 

 

2. Spring Cell – Silver or Gold colored cylinder used to provide a known force profile to 
calibrate the load cell with. 

 

3. Grease Thief Analyzer – The instrument is comprised of a large temperature controlled 
chamber, a moving horizontal table to facilitate the smooth extrusion of the grease samples, 
and a 1 Kg load cell to measure the force profile over the testing sequence. 

 

4. Grease Thief Index – The ratio of the force required to extrude the sample grease to the 
force required to extrude the new reference baseline. 

 

5. Grease Thief – The sampling device used to collect the in-service grease and used to 
extrude the sample during the test procedure. 

 

6. Extrusion Die – A device that attaches to the Grease Thief and creates a thin film of grease 
to be used for testing in the Grease Thief analyzer. 

 

7. Load Cell Scale (K) and Offset – Variables calculated during load cell calibration that govern 
the conversion of the analogue signal to real values with force units. 

 

8. Baseline – New grease used for comparison purposes. The test procedure is purely a 
comparative process and the in-service samples should be compared the new reference 
grease from the same product. 

 

9. Non-Contact IR Thermocouple – This thermocouple monitors the sample uses an infrared 
beam to ensure the test is run at the set temperature. 

 

10. Position Bracket – The silver block in the instrument chamber that holds the Grease Thief in 
place during extrusion. Adjust the clamp with the large black knob. 

 

11. Vertical/Horizontal Actuator – The controller moves the horizontal table ratioed to the vertical 
extrusion to produce a smooth ribbon on the substrate and a consistent load profile. 

 

12. Vector Control Module (VCM) – Acts as the data transfer system for the instrument. This box 
uses ethernet cables to connect the Grease Thief Analyzer, Camera, and LED Controller to 
each other and uses a VGA cable to connect the monitor to the instrument. 

 

13. Particle Counting Camera – Black camera inside the Grease Thief Analyzer used to count 
particles in the extruded grease samples. This is controlled using the Canty Vision software. 

 

14. LED Controller – Black box inside the Grease Thief Analyzer used to control the LED light 
underneath the camera. This is controlled using the Canty Vision software. 
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Appendix IV - Grease Thief® Consumables and Products 

Can be purchased online at www.greasethief.com 
 

Description Part Number 

Grease Thief Analyzer Supplies 

 

Grease Thief Consumables Kit 
 

MGT-02-001 

 

Sampling kits and accessories for your customers to sample and submit for analysis 

 

Pillow Block Bearing Grease Sampling Kit 

 
(this kit can be kept on hand in lab to process 

non-standard sample container submittal) 

 

 
MGT-01-008 

 

MOV Gearbox Grease Sampling Kit 
 

MGT-01-014 

 

Electric Motor Bearing Grease Sampling Kit 
 

MGT-01-012 

 

Robot Drive Gear Grease Sampling Kit 
 

MGT-01-081 

 

Wind Turbine Grease Sampling Kit 
 

MGT-01-067 

 

Grease Sampler Adjustable T-Handle 
 

MGT-01-018 

 

Grease Sampler Metal Double Extension T- 

Handle 

 
MGT-01-001 

http://www.greasethief.com/
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Appendix V - Grease Thief® Analyzer Specifications 
 

Specifications 

Size (length x width x height) 31 x 19 x 29 in (82 x 49 x 74 cm) 

Weight 125 lbs (57 kg) 

Power Requirement 110 VAC; 60 Hz; 5.8 A 

240 VAC; 50 Hz; 2.7A 

Operating Temperature 15 to 40 oC (60 to 104 oF) 

Storage Temperature 0 to 50 oC (32 to 120 oF) 

Sampling methods supported ASTM D7718 – Grease sampling 

 
Environmental Controls 

Programmable PID 
microprocessor controller 

Thermocouple and non-contact 
radiometer temperature sensors 

Continuous preheat for up to 12 
standby samples 

Data output Ethernet 

Display 
4.3” 480x272 pixels LCD display 
with touch screen 

* Three (3) outlets needed for operation 

 
MRG Labs 

410 King’s Mill Road 
York, PA 17403 

1.717.843.8884 ph 
1.425.696.8725 fax 

www.mrgcorp.com 
www.greasethief.com 

 
Grease Thief is a registered trademark of York Laboratories, LLC, and is protected by US patent 7,984,661. The Grease Thief 

complies with ASTM D7718 Standard Practice for Obtaining In-Service Samples of Lubricating Grease, ASTM D7918 Standard Test 

Method for Measurement of Flow Properties and Evaluation of Wear, Contaminants, and Oxidative Properties of Lubricating Grease 

by Die Extrusion Method and Preparation, and AWEA Recommended Practice RP-813 and RP-814. ©2013 

 

 

 
 

 

http://www.mrgcorp.com/
http://www.greasethief.com/
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